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1. INTRODUCTION 
 
Ce rapport détaille toutes les étapes traversée pendant le développement de ce projet, depuis le  
développement de l'idée de base. Afin de ne pas surchargé le rapport d'image, j'en ai mis un 
minimum, préférant indiquer textuellement un maximum des procédures. Les réglages à faire sont 
mis en italique tout au long du rapport  
 
2. DÉVELOPPEMENT DE L'IDÉE DE BASE 
 
2.1.Concept 
 
L'idée de ce cd-rom trouve deux sources. La première étant les exigences du cours STAF 13 qui 
nous demande un projet permettant de travailler sur les images, les sons et la vidéo. Le tout devant 
être intégré dans un cd-rom qui prendrait la forme d'une sorte de visite guidée d'un musée ayant 
plusieurs salles. Ayant deux Lhassa Apso à la maison, je dispose d'une source à demeure pour 
récolter images, sons et vidéo nécessaires.  
La seconde source vient simplement du fait que la plupart des gens ne savent pas à quoi ressemble 
un Lhassa Apso.  
 
2.2. Les salles 
 
J'avais développé une première structure au tout début du projet, mais au final, le temps consacré à 
ce cours ayant été fortement réduis, cette structure a évolué vers quelque chose de nettement plus 
sommaire, tout en tentant de conserver l'esprit de base que je souhaitait donner à ce projet. J'ai 
prévu 5 salles: 
 

• Une première salle est la salle d'accueil. Elle intervient directement et automatiquement 
après le générique d'introduction, et présente un accès direct aux autres salles disponibles: 
des salles thématiques. 

• La première salle thématique dresse un portait de la race grâce à des photos de Lhassa 
trouvées sur Internet. Celles-ci sont accompagnées de commentaires retraçant l'historique de 
la race. 

• La salle suivante est dédiée à mon premier Lhassa: Nachade et est donc remplie de photo de 
Nachade, accompagnées de textes décrivant la personnalité de cette chienne. 

• La troisième salle est l'équivalent de la deuxième, à la différence qu'elle est dédiée à mon 
autre Lhassa: Oxianne. Si le principe reste le même, le visiteur peut ainsi se rendre compte 
que mes deux Lhassa sont très différents l'un de l'autre. 

• La dernière salle est composée d’une petite vidéo d'une trentaine de secondes présentant la 
différence de faculté des deux chiennes. 

 
Les salles sont accessibles de partout, ainsi que la page d’aide et le bouton quitter. Ci-dessous se 
trouve un organigramme sommaire du logiciel. Chaque rectangle représente une page accessible 
depuis les pages qui pointent dessus avec une flèche. Les ronds représentent la même chose, sauf 
qu’en plus, ces pages sont accessibles depuis n’importe où dans le logiciel, quel que soit l'endroit 
où on se trouve dans le logiciel.  
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Fig1. Organigramme du logiciel 
 
L'utilisateur peut ainsi visiter les salles de façon linéaire, ou au hasard de ses envies. 
 
Faute de temps, je n’ai pas pu programmer une page de confirmation pour le bouton quitter. Mais 
cela ne pose conceptuellement aucun problème à faire:  

- Créer l'image d'une petite fenêtre qui demande "êtes-vous sûr de vouloir quitter?" avec en 
dessous (toujours sur l'image) les 2 boutons "Quitter" et "Revenir au programme" dans leur 
état de repos.  

- L'insérer dans Mediator au centre de l'écran 
- Créer ensuite une image de l'état appuyé pour chacun des deux boutons, qu'on superpose à 

leur version "repos" sur la fenêtre.  
- Puis on sélectionne dans les paramètres des 3 images: visible: faux  
- On associe ensuite au bouton quitter: Clique Gauche à Afficher (on choisi l'image de la 

petite fenêtre à afficher) 
- Ensuite, associer des événements à chacune des deux images de boutons appuyé (qui sont 

invisible): 
o Au bouton de confirmation "quitter":  

� Gauche enfoncé à afficher (cette image) 
� Gauche relâché à cacher (cette image toujours) à Quitter 

Ö ainsi quand on croit cliquer sur le bouton au repos de confirmation de 
quitter, on clique en fait sur son état "appuyé", ce qui le fait 
apparaître, et lorsqu'on relâche le bouton, il disparaît et on quitte le 
programme 

o Pour le bouton "Revenir au programme", le principe est le même sauf qu'on 
n'associe pas l'événement "quitter" mais "revenir à la page courante".  
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2.3. Organisation de répertoires de travail 
 
Voici comment j'ai organisé mes répertoires de travail: 
 

 
 
A noter que tous les fichiers se trouvant dans les sous-répertoires Output de PSP, Cool Edit, et 
Premiere ont été copiés dans le répertoire Input de Mediator. 
 
2.4. Organisation du cd 
 
Les salles ont toutes une interface similaire. Seule la couleur de fond et les boutons de navigations 
changent d'une salle à l'autre.  
 
Dans la recherche d'une interface agréable et ergonomique, j'ai fait plusieurs prototypes en cours 
d'année. J'ai demandé conseille sur ceux-ci par rapport à leur ergonomie. Je voulais que l'interface 
soit le plus instinctive possible. Arrivé à un prototype papier que je jugeait abouti, j'en ai fait une 
version informatisée pour mieux me rendre compte de ce que cela donnerait (cf Fig2). J'ai fait cette 
image avec le programme de dessin "paint" de Windows car à ce moment là de l'année, je gérais ce 
logiciel aisément, et n'avais que peu travaillé sous Paint Shop Pro. 
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Fig 2: Prototype informatisé de l'interface 

 
Cette interface contient trois zone principales: 

- La première, en haut à gauche, est la zone de menu du CD-Rom. Elle contient un accès 
direct à toutes les salles: les 4 salles thématiques, la salle d'accueil et le bouton quitter. 
L'icônes de la maison envoie vers la salle d'accueil, l'icône de la salle vidéo restera ce 
symbole, mais pour les salles "images", je remplacerai le numéro par une photo du chien. 

- La deuxième, centrale, est la zone d'affichage des images et de leurs commentaires, ou de la 
vidéo. Dans la salle d'accueil, cette zone contiendra 4 images représentatives des salles, et 
par lesquelles on pourra accéder aux-dites salles. 

- La dernière zone, en bas à droite, est la zone de gestion des images ou des vidéo (zone de 
navigation). Là se situent tous les boutons servant à naviguer à l'intérieur de la salle: d'une 
image à l'autre, ou à gérer les vidéo, ainsi que le bouton d'aide 

 
Remarque: ce prototype avait pour seul but de me guider pendant le développement du logiciel, il 
n'est là que pour donner une idée générale du tout, des détails on changé entre temps. 
 
3. PAINTSHOP PRO 7 
 
Toutes les images crées avec PSP ont leur sources dans le fichier PSP > Input et leur résultat final 
dans le fichier PSP > Output. C’est le même principe utilisé pour les autres outils. 
 
3.1 Création de l’interface du projet 
 
3.1.1. Créer une nouvelle image 
 

- Fichier > new 
- taille : 600x800 pixels 
- background : transparent 

 
Remarque: ici, la couleur de fond va changer, mais prendre l'habitude de mettre la couleur de fond 
en transparent est utile par la suite, lorsque l'on fait une image que l'on veut exporter en gif 
transparent 
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3.1.2. Créer un nouveau calque 
 

- Layers > New Raster Layer. Le nommer "menu" C’est la zone en haut à gauche (cf dessin 
Interface) 

- Dans ce calque, dessiner un rectangle, puis un  cercle qui recouvre le rectangle de la zone à 
amputer 

- Effacer ensuite le cercle, et on se retrouve avec notre rectangle tronqué. 
 
La marche à suivre est exactement la même pour créer la zone de navigation sur un autre calque. 
 
3.1.3. Emplacement des boutons 
 
Créer ensuite des espaces pour les boutons de navigation et les boutons de menu. C'est toujours le 
même principe de base. 

- Créer un calque: Layers > New Raster Layer, puis le nommer. 
- Créer une petite forme de la taille du boutons (une série de boutons rond pour le menu, et 

une série de boutons carrés au coins arrondis pour la navigation dans une salle.) 
- Une fois la forme crée, la copier en la sélectionnant grâce à  puis, sur le nouveau calque, 

on fait un clique droit sur la barre de menu de l'image (bande bleue en haut de l'image) > 
Paste as a new selection 

- On répète l'opération autant de fois qu'il y a de boutons, puis on les place comme il 
convient, en les sélectionnant un à un. 

 
Pour le bouton d'aide en point d'interrogation, le principe reste le même, sauf que la forme est un 
point d'interrogation au lieu d'être un rond. 
 
3.1.4. Nom des Salles  
 

- Créer un nouveau calque Layers > New Raster Layer 
- Sélectionner l'outil texte ( ) 
- Dans la boite "Create as" sélectionner "new selection" 
- Options a sélectionner: Antialias / Auto-kerning / Standard texte 
- Police: Name: Chasm /  Size: 22  pour les noms de salles  
- Cliquer OK 
- Ensuite, déplacer le texte à sa place  

 
3.1.5 Titre des salles 
 
Pour le titre des salles (le titre "Salle" tout en haut de l'écran), la démarche commence de la même 
manière (avec les paramètres adéquats), puis ajouter un effet 3D et une ombre : 

- Cliquer sur l'outil texte,  
o Police: Name: Chasm / Size: 36  /  
o Couleur: Dans la boite Style, sélectionner la même couleur que celle de la zone 

centrale de l'interface pour le Fill 
o Options à sélectionner : Bold / Italic / Floatting / anti-alias / auto kern 

- Cliquer sur OK 
- Créer un effet 3D: Effects > 3D Effects > cutout 

o shadow color: noir / Opacity: 50 / Blur: 2 / Vertical: 3 / Horizontal: 3 
o Option à ne pas cocher: Fill interior with color 
o Cliquer sur OK 
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- Faire une ombre: Effects > 3D Effects > drop Shadow 
o Color: Blanc / Opacity: 51 / Blur: 1 / Vertical: 2 / Horizontal: 2  
o Cliquer sur OK 

 
3.2. Acquisition des photos 
 
Les photos à « l’état brut » se trouve dans un répertoire PSP > Photo > Input dans lequel on trouve 
deux sous-répertoire : Photo perso (où se trouvent les images des photos scannées de mes chiens) et 
Photo Internet (où se trouvent les images de Lhassa Apso trouvées sur Internet) 
 
Les photos scannées, j’ai commencé par les redimensionner à 50% de leur taille originale, car cela 
permettait un stockage moins lourd des images, tout en leur laissant une taille supérieure à ce qui 
serait nécessaire par la suite:  

- Sélectionner l'image à redimensionner 
- Image > Resize (Shift+S) 
- Percentage of original : Width 50% / Height 50% 

 
3.3. Nettoyage des yeux rouges 
 
Enlever les yeux rouges sur les photos qui le nécessitait : 

- Effect > Enhance Photo > Red-eye Removal 
o Method: Auto Animal Eye 
o Cocher la case  center glint 
o Color : choisir la case n°3 (black, dog) 
o La valeur des options Pupil lightness, Glint lightness, Glint size sont à choisir en 

fonction de la photo que l'on est en train de nettoyer. 
 
3.4. Redimensionner  des photos 
 
Je voulais que toutes mes photos fassent 300x240, qui est la taille de la vidéo aussi. Afin d’avoir 
une unité de position des images, ainsi qu’une unité d’occupation de l’espace. J’ai ainsi du 
redimensionner mes images : 

- Image > Resize (ou Shift+S) 
- Width: 300 / Height : 240 / décocher l’option maintain aspect ratio of  

 
Cette manipulation occasionne une légère déformation de l’image si celle ci n’a pas une proportion 
avoisinant le 5/4 (i.e. le rapport de 300/240) pour éviter que la déformation ne devienne visible, il a 
parfois fallu couper des bouts de l’image avant de redimensionner, afin de s’approcher le plus de ce 
ratio : 

- Sélectionner la zone de l’image qu’on veut conserver. 
- Image > Crop to selection (ou Shift+R) 

 
3.5. Mettre des cadre aux images 
 
Ensuite, j’ai mis des cadres aux images, à l’intérieur des images, afin de conserver la dimension 
que j’avais choisi : 

- Image > picture frame > PhotoEdge01 
- Cliquer sur suivant 
- Choisir Frame inside the image 
- Cliquer sur terminer 
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Comme le cadre est mis sur un nouveau calque, on peut en sélectionner certaines parties pour les 
enlever.  
 
Remarques: Comme le cadre choisi est irrégulier, certaines zones gênaient  parfois sur certaines 
images. J'ai dû les gommer: 

- à l'aide de l'outil , sélectionner la zone gênant la visibilité 
- puis, la gommer avec  

 
3.6. Boutons Salles 
 
Il m'a ensuite fallu créer des boutons de la taille des formes disposées dans l'interface. Pour les 
salles, je voulais que le bouton soit une photo du chien (pour les salles Nachade et Oxianne), une 
photo de plusieurs Lhassa pour la salle du même nom, et un icône de film pour la salle vidéo 
 
Il m'a donc fallu commencer par faire des pastilles rondes de la taille des boutons que je voulais. 
Ces pastilles sont des rond de la même taille que l'espace laissé pour le bouton sur l'interface, mais 
il s'agit de la photo qui servira de base au bouton. 
 
3.6.1. Transformer une photo en la pastille désirée 
 

- Copier un des rond jaunes de mon interface dans le presse papier pour avoir la taille exacte. 
o Sélection du rond jaune (sur le calque adéquat) 
o Ctrl +C 

- Ouvrir une nouvelle image : File > New 
- Coller comme nouvelle sélection: 

o Clique droit sur la barre de titre de la nouvelle image (barre bleue en haut) 
o Paste as a new selection 

- Dessiner une forme plus grande que le rond (un rectangle) et d'une autre couleur 
- Déplacer le rond sur le rectangle, puis le sélectionner avec , et l'effacer. Le résultat est un 

rectangle avec un trou de la taille de la pastille.  
- Sélectionner cette forme et la copier. 
- Ouvrir l'image dont on veut tirer une partie comme pastille 
- Redimensionné cette image pour qu'elle ait la taille désirée  

o Shift +S pour ouvrir la boite de dialogue de resize 
o Travailler dans la case Percentage of original qui permet de demander un 

redimensionnement de la photo en fonction du pourcentage par rapport à l'originale 
o Laisser l'option Maintaint Aspect Ratio sélectionnée, ce qui permet à l'image de 

conserver ses proportions de base. 
o A partir de là, c'est une approche par essais-erreurs, jusqu'à avoir la taille idéale 

- Coller la forme sur la photo et la placer de façon à voir la partie désirée de la photo ressortir 
dans le trou de mon rectangle. 

- Sélectionner ensuite tout ce qui n'est pas la pastille et l'effacer. 
- Faire un Save as de la pastille. 

 
3.6.2.  Boutons surélevés 
 

- Reprendre la pastille.  
- transformer l'image en bouton: Effect > 3D Effects > Inner Bevel 
- Les options choisies sont les suivantes: 
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o Dans Bevel:  / Width: 6 
o Dans Image: Smoothless: 10 / Depth: 13 / Ambience: 0 / Shininess: 0 
o Dans light: color: blanc / angle: 315 / Intensity: 50 / Elevation: 30 

- Redimensionner ensuite l'image aux exactes dimension du bouton: 
o Sélectionner la zone extérieur du bouton avec la baguette magique 
o Selections > invert 
o Image > Crop to selection (Shift+R) 
o Avec la baguette magique, sélectionner toutes les zones extérieures au bouton (en 

appuyant sur shift en même temps, on peut sélectionner plusieurs zones) 
o Selections > invert 

 
Remarque: ne pas sélectionner tout de suite le bouton parce qu'il contient plusieurs couleurs, et 
donc l'outil "baguette magique" ne le sélectionnerait pas comme un tout. 
 
Il faut maintenant sauver le bouton en gif transparent, pour ne voit pas le background lors de 
l'importation dans Mediator: 
 

- Fils > Export > Gif optimizer 
- Choisir dans l'onglet Transparency: outside the current selection 
- Choisir dans l'onglet Partial Transparency:   

o Use transparency for pixel below 60% opacity 
o No, use the existingimage color at 100% opacity 

- Choisir dans l'onglet Colors: How many colors do you want: 256 / Optimized Octree / 
Include Windos colors 

- Choisir dans l'onglet Format: Non- Interlaced / Version 89a 
 
3.6.3. Boutons enfoncés 
 

- C'est le même principe. La seule différence est le bevel choisi ( ) 
 
3.7. Une couleur pour chaque salle 
 
J'ai ensuite voulu faire un exemplaire de l'interface de couleur différente pour chaque salle.  
J'ai donc sauvegarder mon interface.pps sous un autre nom que j'ai modifié. 
Il m'a suffit donc de changer les couleurs de chaque zone, calque par calque. La seule chose à 
refaire chaque fois étant le titre, puisqu'on ne peut pas agir un texte déjà posé. Pour ce faire, je 
créait un nouveau calque, je refaisait le titre, je le mettait en place par dessus celui existant, puis 
effaçait le calque du premier titre, devenu inutile. Cet opération permet d'avoir conservé la même 
position pour le titre quelle que soit l'image. 
 
Problème, dans les zones Menu et Navigation, le changement de couleur de la zone (sélection de la 
zone et remplissage avec une autre couleur) laissait une bordure bleue. Pour palier à cela, j'ai 
procédé calque par calque: sélection de la zone, puis sélection de la partie vide (en appuyant sur 
shift, ça garde les 2 zones en sélection), on inverse la sélection (Selections > Invert) de sorte qu'on 
ne se retrouve plus dans la sélection qu'avec la bordure bleue à éliminer. Sélection de l'outil  
qu'on utilise pour changer la couleur la bordure bleue. Et comme c'est la seule partie de l'image 
sélectionnée, on peut faire d'amples mouvements qui "dépasse les lignes" sans conséquences. 
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Remarque: il ne faut pas faire d'ombre aux objets sous Paint Shop Pro. C'est une opération qui se 
fait sous Mediator, sinon, l'importation des objets posent certains problèmes (de mise en page entre 
autres). 
 
4. ADOBE PREMIERE 
 
4.1 Montage de la vidéo 
 
Ayant enregistré des séquences de vidéo avec mes chiens, je suis ensuite passé à la salle 
multimédia d’UNI-MAIL afin de faire une importation sur support informatique. Ne disposant pas 
des connaissances nécessaires du matériel ou des logiciels de captures, et ayant peu de 
connaissances préalables quant aux différents formats et aux subtilités les concernant, je me suis fié 
au régisseur de la salle. Une première tentative d’importation sous format AVI s’est avérée 
inutilisable sous Adobe Première qui est pourtant sensé prendre ce format en compte (le fichier 
semble corrompu). Une seconde tentative a consisté à faire l’importation en format DV, afin 
d’importer les fichiers en flux DV sous Premiere. Seulement, comme cette importation depuis la 
cassette DV c'est faite avec un Mac, il a encore fallu rajouter une extension *.mov aux fichiers. J’ai 
dès lors pu travailler mes films dans Premiere 
 
Le but était de monter une petite séquence vidéo montrant les différences de capacités de mes 
chiennes, en y insérant au début de la séquence environ 5 secondes d’arrêt sur la première image 
pendant lesquels prend place un commentaire audio, puis seulement après, le film démarre. La 
séquence dure environ 28 secondes, et se termine par un écran de fin qui contient un commentaire 
animé qui arrive contre l'écran, tout en étant synchronisé avec une version sonore du même 
commentaire. 
 
4.1.1. Paramètres du projet 
 
Ouvrir un projet auquel on applique les paramètres suivants : 

- DV PAL / standard 32 Khz 
o Cliquer sur Autres 

- Dans Général : Video for Windows 
o Cliquer sur Suivant 

- Dans Vidéo : codec cinepack de Radius / 300 x 240 (c’est un choix de ma part en fonction 
de mon interface) / qualité:  75% / 15 images par secondes / D1 DVPAL (1.067) 

o Cliquer sur Suivant  
- Dans Audio : 22050 Hz / 16 bits mono  

o Cliquer sur Suivant 
- Dans Image clé et rendu : dans la case de prévisualisation: Depuis le disque 

o Cliquer sur OK 
 
Importer ensuite les séquences vidéos sur lesquelles on veut travailler dans le chutier : 

- Fichier > Importer > Fichier (ou Ctr + I) 
 
4.1.2. Couper le fichier du film 
 
Mettre dans la piste de Vidéo 1A la séquence qu'on souhaite travailler, par drag&drop depuis le 
chutier. Cette séquence contient un cut dans le fichier de base, i.e un moment pendant le tournage 
ou j’ai arrêté la caméra pour recadrer le chien. J’ai donc dès la coupure, déplacé la 2e partie de cette 
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séquence vers la piste 1B, et je les ai fait se chevaucher de 1 seconde. Cette manipulation m’a 
permis d’introduire un fondu : 

- couper le fichier au moment du film qui coupe entre 2 prise, avec l'outil  
- Déplacer par drag&drop la 2e partie du fichier sur la piste 1B, en faisant chevaucher les 2 

partie d'une seconde environ (ce sera le temps de la transition) 
- Sélectionner la transition désirée (fondu enchaîné) depuis la fenêtre des transitions, et la 

placer dans la piste transition. Elle se cale toute seule afin de couvrir la zone de 
chevauchement des 2 pistes vidéo. 

 
Je voulais que la vidéo soit bloquée quelques secondes sur la première image afin de pouvoir y 
mettre un commentaire audio, puis seulement la vidéo démarre. 
 
4.1.3. Image Statique des 5 premières secondes 
 
J’ai coupé la première image pour l’isolé du reste de la bande, et je lui ai appliqué des 
modifications : 

- clique droit sur l’image > Vitesse :  
o fréquence : 1% 
o durée 0 :00 :04 :05  

La durée choisie est la durée du commentaire, comme cela, l’image reste statique tant que le 
commentaire défile, puis démarre juste après. 
 
4.1.4. Commentaires  
 
Pour le commentaire illustrant la vidéo, j’ai simplement enregistré ma propre voix. J’ai branché un 
micro dans la carte son de l’ordinateur, ouvert le magnétophone de windows, appuyé sur REC, dis 
mon texte, et sauvegardé le fichier son en format WAV. Je l’ai par la suite importé dans la piste 
Audio 1 de mon projet comme je l’ai fait pour les séquences vidéo (i.e. en l’important d’abord dans 
le chutier). Enfin, j’ai modifié sa vitesse à 80% de la vitesse originale afin que la voix soit plus 
grave. 
 
La bande son de l’enregistrement n’étant pas de bonne qualité, j’ai enregistré les ordres que je 
donnais au chien (selon le même principe, mais sans changer la vitesse de déroulement), puis ai 
synchronisé ces fichiers WAV sur l’image durant le montage. 
 
4.1.5. Ecran de fin 
 
Je voulais terminer le film sur un écran de fin montrant la phrase « Etonnant, non ? », lequel écran 
montrerait ce texte avec un effet de zoom grossissant, le tout synchronisé à un commentaire sonore 
disant le même texte. La marche à suivre est la suivante : 

- Ouvrir un nouveau document de titre : Fichier > Nouveau > Titre 
- S’ouvre alors une fenêtre-titre dans laquelle on écrit le texte. 
- On décide de la couleur de fond : Clique droit > option de la fenêtre titre > fond.  

o Remarque :noter les valeurs RVG de la couleur choisie, utiles par la suite 
- Sauvegarder le document, puis l’importer dans le chutier 
- Insérer le titre dans la fenêtre de montage comme n’importe quelle autre séquence vidéo 
- Travailler les effets du titre : sélectionner la séquence titre dans la fenêtre de montage, puis 

faire clique droit > options vidéo > trajectoire 
- Dans cette fenêtre, remettre la même couleur de fond que pour l’image, en vous référant aux 

valeurs RVG notés auparavant. 
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- Ensuite, il faut paramétrer la trajectoire de l’image selon l’envie : ici j’ai fait une descente 
du texte progressive depuis en dehors de l’image jusqu’à son centre, avec un effet de zoom 
grossissant.  

 
Remarque: procéder par affinage, en laissant la simulation de la trajectoire en continu, comme cela 
on se rend compte en temps réel du résultat. 
 
4.1.6. Exportation 
 
Tout au long du montage du film, on peut sélectionner des petit bout du montage (règle supérieure 
de la fenêtre de montage, dont le bout sélectionné apparaît en jaune) dont on fait la prévisualisation 
(Montage > prévisualiser). Cela permet de voir les transitions par exemple. 
Une fois le résultat final obtenu, il faut exporter la séquence, afin qu’elle puisse être visionnée 
comme un petit film : 

- Fichier > exporter le montage > Séquence 
- Choisir ensuite le titre du fichier, celui-ci sera exporté en avi. 

o Remarque : on peut remanier les paramètres du projet à ce stade là, mais ce sont les 
paramètre déterminés à l’ouverture qui sont là, donc à n’utiliser que si on a changé 
d’avis entre temps. 

 
4.2. Générique 
 
J'ai ici commencé par faire une mind map de mon générique grâce au logiciel Inspiration. Cette 
mind map m'a servi de storyboard de mon générique. 
 

 
 

Fig 3: storyboard du générique 
 
J'ai ensuite pu monter mon générique dans Premiere. J'ai repris les mêmes paramètres que pour la 
vidéo (cf. Montage de la vidéo), sauf pour la taille. En effet, si la vidéo faite avant doit s'insérer 
dans l'interface, et donc faire la même taille que les autres images (300 x 240), le générique sera en 
plein écran, j'ai donc choisi 800 x 600. 
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J'ai commencé par le Titre principal en arrangeant un peu le design avec les options à disposition 
(police, taille, style, ombre, couleurs,…).  
 
Puis j'ai fait les petits titres d'informations et de contexte sur le CD-Rom. J'en ai fait un que j'ai 
redimensionné dans le quart inférieur droit de l'écran. Puis je lui ai imposé une trajectoire qui le 
faisait apparaître depuis le bas, montant jusqu'à sa position intermédiaire (centre du quart inférieur 
droit de l'écran), y restant pendant le tiers central de son trajet, puis disparaissant vers la droite. 
Comme je voulais que tous ces petits titres aient la même trajectoire, j'ai enregistré celle-ci (dans la 
fenêtre trajectoire: enregistrer), afin de pouvoir l'appliquer telle quelle aux autres titres (dans la 
fenêtre trajectoire: charger).   
 
Une autre méthode plus rapide consiste à faire des copies du fichier du petit titre, de changer les 
noms de ces copies, puis de les ouvrir et de changer le texte du titre. Ainsi, non seulement la 
trajectoire est déjà en place, mais le texte se trouve directement à la même position relative que les 
autres, ce qui est un gain de temps. 
 
J'ai fait la même démarche pour les images devant occuper le quart inférieur gauche de l'écran. 
 
Remarque: j'ai monté les images de Lhassa sur la piste vidéo n°1 afin de pouvoir les faire défiler 
avec une transition, la piste n°1 étant la seule piste permettant cela 
 
5. COOL EDIT 
 
Une fois mon générique terminé au niveau de l'image, je me suis occupé de la bande son. J'ai relevé 
le temps complet du générique sous Premiere (39.01 sec), puis ai cherché dans ma collection de 
MP3 un morceau contenant 39 secondes pouvant ête utilisées pour faire une bande son agréable. Je 
me suis arrêter sur "From the heart" du groupe "Another Level". J'ai ensuite utilisé un programme 
d'encoder MP3 (AltoMP3 maker) pour décoder ce morceau en wav. J'ai ensuite ouvert ce fichier 
wav sous Cool Edit, et n'ai gardé que les 39 secondes m'intéressant (en sélectionnant les parties à 
couper et en les supprimant), puis j'ai amplifier le début du morceau pour que le volume passe de 0 
au début du morceau à 100% de son volume initiale en 2.2 secondes: 

- sélectionner les 2.2 premières secondes 
- transform > amplitude > amplify 
- Initial amplification: 0% / final amplification: 100% 
- Cliquer OK 

 
Pour que le volume en fin de morceau baisse progressivement, le principe est le même sauf qu'il 
faut inverser les pourcentages: Initial amplification: 100% / final amplification: 0% 
 
Remarque: le choix du temps sur lequel se fait l'amplification est à faire en regardant ce qui se 
passe au niveau de l'image, afin de synchroniser.  
 
Une fois la bande son terminé, on l'importe sous Premiere, dans le chutier de notre projet, on la 
glisse dans la piste audio n°1 (la seule utilisée ici), puis on exporte le tout de la même manière que 
l'on avait exporté la vidéo. 
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6. MEDIATOR 
 
Remarque : à noter ici que les fichiers présents dans le dossier Mediator > Input sont en fait tous 
les fichiers que l’on trouve dans les dossiers Output des autres outils. De plus, le fichier Output de 
Mediator n’existe pas sous ce nom, il est nommé CD-Rom et contient tous les fichiers qu’il faut 
pour faire marcher la version exécutable du logiciel.  
 
6.1. Création des pages 
 
J'ai commencé par créer autant de pages qu'il m'en fallait: 

- 1 pour l'accueil ; 
- 1 pour la vidéo et ;  
- 6 par salles: 5 (1 par image) +  1 (où sont présentés des thumbnails de chaque image 

disponible dans la galerie). 
 
6.2. Importation des images 
 

- sélectionner  
- cliquer sur la fenêtre de travail 
- choisir la bonne image 
- cliquer OK 

 
6.3. Boutons 
 

- importer l'image de l'état "repos" du bouton d'accès au salles (les ronds avec le tête des 
chiens) 

- Dans les propriété de l'image du bouton au repose, sélectionner: 
o Sous l'onglet Ombre (le 6e): Activer ombre: vrai 

- importer l'image de l'état "appuyé" du bouton, et le placer à la même place que l'image d'état 
"repos" 

- Dans les propriété de l'image du bouton appuyé, sélectionner:  
o Sous l'onglet couleur (le 4e) : activer couleur transparente: vrai 
o Sous l'onglet général (le 1er) : visible: faux 

 
Remarque: sans que j'ai pu déterminé pourquoi, la couleur transparente de mes gif transparent était 
un violet pétant. Si un tel cas se produit, il faut déterminer sous l'onglet couleur quelle est la couleur 
transparente, en sélectionnant  et en cliquant sur la zone qu'on veut ne plus voir. 
 
J'ai ensuite associé des événements à l'image de bouton au repos. Pour associer des événements à 
une image, il suffit de la sélectionner (en faisant un clic droit dessus ou dans la liste des objets 
p.ex.) c'est la première proposition. Dans la fenêtre des événements: 

- Associer Gauche enfoncé à afficher. On choisi d'afficher l'image du bouton enfoncé. 
- Associer Gauche relâché à cacher. On choisi de cacher l'image du bouton enfoncé. 

 
Le principe est le même pour tous les boutons. 
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6.4. Bulles infos 
 
Bulles avec le nom de la photo et ses dimensions. Apparaissent quand on enfonce le bouton droit de 
la souris sur la photo, et disparaît quand on relâche le bouton droit de la souris. Le principe est le 
même que celui employé jusqu'ici:  

- Créer sous PSP une bulle pour chaque image, avec deux couches (une pour la bulle et une 
pour le texte); 

- Les exporter en gif transparents. 
- Les importer dans Mediator, 
- Les placer, choisir les options suivantes:  

o Sous l'onglet général (le 1er) : visible: faux 
o Sous l'onglet couleur (le 4e) : activer couleur transparente: vrai 
o Sous l'onglet Ombre (le 6e): Activer ombre: vrai 

- Puis associer à l'image les événements: 
o Associer "Droit enfoncé" à "afficher". On choisi d'afficher l'image du bouton 

enfoncé. 
o Associer " Droit relâché" à "cacher". On choisi de cacher l'image du bouton enfoncé. 

- Pour varier un peu, attribuer à ces 2 événements des transitions rapides: dans les paramètres 
des événements " afficher " et " cacher ", sélectionner zoom centré dans l'onglet "Zoom" / 

Durée: 400 ms / réglage de la vitesse:   
 
6.5. Importation des vidéo 
 
Qu'il s'agisse du générique ou de la vidéo de la salle vidéo, le principe reste le même. 

- sélectionner  
- cliquer sur la fenêtre de travail 
- choisir le bon fichier vidéo 
- cliquer OK 

 
Les différences sont les suivantes:  

- dans les paramètres des vidéo, l'option auto-démarrer de l'onglet général (le 1er) 
o pour le générique: vrai 
o pour la vidéo : faux 

- ensuite, si aucun événement n'est associé à la vidéo de la salle, le générique est associé à 
deux événements: 

o Démarré (permet au générique de démarrer dès que l'on exécute le programme) 
o Arrêté associé à Aller à la page (permet qu'à la fin du générique, le programme parte 

seul à la page suivante) 
- Pour que la bulle d'information de la salle soit visible lorsqu'elle est activée: 

o décocher l'option toujours visible de la vidéo 
 
6.6. Titres animés 
 
Dans la salle d'accueil, je voulais que le titre "Choisissez votre salle" vienne dans l'écran, tout seul, 
lorsque la page s'affiche: 

- Créer le titre avec l'outil  
- Créer un trajectoire avec l'outil  
- Associer un événement non pas à un objet de la page, mais à la page elle même: 

o Démarrer – Ligne de temps 
� Double-clic sur Ligne de temps 
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� Insérer l'événement trajectoire, le faire démarrer au moment voulu, et lui 
associer le titre et la trajectoire qu'on a défini pour lui.  

 
La même technique est utilisée pour les commentaires des salles. 
 
Remarque:  est l'outil "titre" de Mediator, alors que le même icône est utilisé pour l'outil "Texte" 
de Paint Shop Pro 
Remarque: ici pour la première fois, on associe un événement non pas à un objet d'une page, mais à 
la page elle-même.  
 
6.7. Etiquette du fonctionnement des boutons 
 
J'ai fait des étiquettes détaillant le fonctionnement des différents boutons. Ces étiquettes sont 
invisibles, sauf quand la souris est sur le bouton. Pour cela: 

- dans l'onglet Général des propriétés de l'image "Etiquette: sélectionner: visible: faux 
- Associer à l'image du bouton "repos" les événements: 

o Dedans – Afficher (Etiquette) 
o Dehors – Cacher (Etiquette) 

 
Remarque: faute de temps, je n'ai mis en place les étiquettes que pour la salle Accueil, toutefois, les 
images sont toutes prêtes dans le dossier Mediator > Input (et dans le fichier PSP > Output) 
 
7. PROBLÈMES NON-RÉSOLUS 
 
Une première constatation concerne le fait que j'ai travaillé seul sur ce projet, c'est à cette occasion 
que j'ai pu mesuré toute la richesse du développement d'un projet à 2 personnes. Premièrement, cela 
permet de réduire la masse de travail. Ensuite, cela permet d'avoir un retour sur son travail, ce qui 
permet de l'améliorer au fur et à mesure du développement. Enfin, ça enrichi les idées et stimule la 
créativité. 
 
Les problèmes cités ci-dessous sont restés au stade de problèmes, faute de temps. Ce ne sont pas 
des problèmes majeures, mais les résoudre améliorerai la qualité de certains points. 
 
7.1. Son 
 
J'ai eu des problèmes avec la qualité des sons. La bande sonore de la vidéo que j'ai fait de mes 
chiens, n'a pas résisté à l'encodage sur Mac. Pour palier à cela, j'ai enregistrer des commentaire 
directement sur le pc (en format wav) pendant le montage de la vidéo, en fonction des besoins, puis 
je les ai synchronisé avec l'image. Mais le son est de mauvaise qualité, plein de parasites. Je n'ai pas 
eu le temps de chercher une manière de faire plus "propre". 
 
7.2. Générique 
 
Une fois exporté de Premiere (en format avi), le générique, manque d'une certaine netteté, malgré le 
fait que j'ai spécifié que la taille de la fenêtre serait en 800 x 600.  
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7.3. Les étiquettes de fonction des boutons 
 
Ces étiquettes n'ont été mises en place que dans la salle accueil, faute de temps. Les images sont 
toutefois disponibles dans les fichiers Mediator > Input, ainsi que PSP > Output. Elles sont ainsi 
prêtes à être mises en place ultérieurement 
 
7.4. Le bouton LEG 
 
Ce bouton ne fonctionne pas dans cette version du logiciel. Il devait avoir la fonction de 
cacher/afficher les commentaires. Mais ayant fait des animations pour les commentaires, je trouvais 
dommage de permettre à l'utilisateur de les cacher, de plus, il n'est pas obligé de les lire. Donc, ce 
bouton n'a pas été mis en application, mais comme tout était en place à part cela, je l'ai laissé, et ai 
signalé dans la page d'aide qu'il ne servait à rien dans cette version du logiciel. 
 
7.5. Les thèmes sonores des galeries 
 
Je n'ai pas associé de thèmes sonores aux salles. Conceptuellement c'est pas un problème, la 
démarche est la même que pour la musique du générique. Ensuite on l'importe comme fichier 
sonore dans la page que l'on désire avec l'outil . Attention, il faut le mettre en dehors du cadre si 
l'on veut que cela ne soit pas gérable par l'utilisateur. Dans les propriétés de l'objet, on sélectionne 
auto-démarrage : vrai. Et le tour est joué. 
 
8. CONCLUSION 
 
Si j'ai de la peine à être pleinement satisfait de la qualité graphique de mon projet et de son 
aboutissement, je suis en revanche content d'avoir appris la gestion d'outils tels que Paint Shop Pro, 
Premiere, Cool Edit et Mediator. J'ai acquis les bases suffisantes pour pouvoir gérer un projet 
multimédia seul, et j'ai maintenant une meilleure idée du temps que prennent les différentes étapes.  
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